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About PatBase Analytics 

 

PatBase Analytics offers fast analysis of up to 250,000 PatBase records in one go. It is 

included, at no extra charge, with every PatBase subscription. 

 

Accessing Analytics 

 

Access PatBase Analytics from the “View” or “Hits” mode from this icon    found at 

the top of the records within PatBase. Alternatively access PatBase Analytics from the “More...” 

option found on the History page for all search queries. 

 

An additional entry point for PatBase Analytics is to visit the Analytics interface directly (as 

long as you are logged into PatBase) where you can modify the settings, run searches, and 

re-run previous saved analyses, you can log-in directly to Analytics V2 using your usual 

PatBase account. 

 

 

Analysis Choices 

 

After selecting “Analytics” in PatBase, PatBase Analytics will open in a new tab in your 

browser. Here you can select whether you wish to access V2 directly, or go to the settings 

page, where you can customise your analysis.  

 

Alternatively, you can access a preview which will analyse and take you to the main page for 

the selected section only, or you can choose to go directly to your saved searches.  There is a 

box you can check to remember your choice for future visits. 
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Analysis Settings 

 

The Settings menu allows you to modify your Analytics settings to adjust what is and is 

not analysed, the depth of the analysis conducted (Basic, Standard or Deep), the default 

settings (which are remembered for your next Analytics session), the style and colour of 

the charts, and the assignee and jurisdiction groups. Furthermore, there is the option to 

Reset one or more of your settings. 
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Dashboard page, widgets and main settings 

 

Dashboard page 

 

The Dashboard page provides an overview of your analysis, which is detailed in individual 

widgets. A selection of widgets will automatically be displayed when accessing PatBase 

Analytics. 

 

Widgets 

 

The widgets in the Dashboard provide a visual summary of the data analysed and will vary 

depending on the data analysed (based on your settings). 

 

 
 

The Dashboard also provides some basic details of your analysis, the first and last 

publication date in the result set, the executed PatBase search, the type of data and the 

number of families, granted patents, applications, and total publications within the result 

set.  

 

Furthermore, the search name (generated or user created), the date and time of the 

analysis, and the actual PatBase search time is shown. There is the ability to filter the data 

by jurisdiction, assignee, date or patent type by clicking on the filter icon and selecting 

the appropriate filters. 
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Each widget can be minimised or closed by clicking on the icons in the top right-hand 

corner of the widget. Clicking on the link icon within a widget takes the user to the 

corresponding detailed chart. 

 

You can also view the chart in full screen view by selecting the expand (arrows) icon, use 

the toggle to show or hide the data labels for each metric (where applicable) or choose 

whether to display the bars as horizontal and vertical (where applicable). Clicking on the 

link icon within a widget takes the user to the section of AnalyticsV2 where you can fully 

investigate all of the available data. 

 

 
 

Additional functionality exists within the Dashboard to maximise the user experience including 

the ability to (see next page): minimise the main Analytics menu (1), switch between Analyses 

within your current PatBase session (2), select the primary chart default setting which provides 

different levels of insight (numerical, breakdown or graphical) (3), filter your analysis by 

publication date (4), and to change the language of the interface (5).  
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Main settings 

 

You can access the “Settings” page in the Analytics menu, where you can modify the data 

analysed in Analytics, the depth of the analysis, display settings, and reset your settings. 

Furthermore, you can personalise Analytics by adding your name, company, and a photo or 

logo. 

 

 
 

Analysis 

 

Within the Analysis section you have the option to turn on or off the data which is analysed in 

PatBase Analytics (e.g. jurisdictions, assignees), and whether sampling is used for large result 

sets (over 25,000 families). Note that turning off the analysis of types of data which are not of 

interest will speed up the analysis to varying degrees, and this has been indicated by the labels: 
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low, medium and high. Turning off the analysis of keywords or legal status for example, will 

significantly reduce the time needed to complete the analysis. 

 

The sample, when used, is selected from the families of your result set. Therefore, if the same 

family population is sampled on numerous occasions, the analysis will not always be identical, 

but it would bracket the true population within the selected error margin at the selected 

confidence level (both of which will vary given the size of the population). 

 

Depth 

 

The depth of the analysis can be adjusted by selecting either “Basic”, “Standard”, or 

“Deep”: 

 

• Basic – basic analysis including dashboard widgets and Summary sections 

• Standard – deeper analysis, with secondary breakdowns, drilldowns and open 

secondary series charts 

• Deep – full analysis, including ternary breakdowns and drilldowns. The finest 

available granularity; down to individual events and publications (where available) 

 

Please note: the depth of analysis selected will influence the speed of the analysis and 

the data available for review. 

 

Please note: clustering and random sampling is used in some cases. For example, if your 

result set includes tens of thousands of legal events, it is simply not possible to plot them 

all on a meaningful chart (the chart may become confusing, and in some cases 

unintelligible). To overcome this, we will plot a number of points - representative of the 

whole - that allows for an accurate interpretation of the full population. 

 

Defaults 

 

The Defaults section allows you to select the default settings for the charts, jurisdiction & legal 

status categories, dashboard, general layout & comparison analyses.  

 

This includes three levels for the primary chart default settings, which have been designed to 

accommodate a range of users and requirements: 

 

Numeric: this option will default charts to the simplest available chart type. The default will be 

to show a simple numeric representation of the data (for example the number of assignees in 

a jurisdiction, or the number of years in which a grant has been issued). Designed for the user 

that wants to focus on the basic numbers. 
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Breakdown: this option will show a breakdown of the data with the second dimension of 

data visible by default (for example specific assignees in a jurisdiction will be shown, or the 

years in which a grant has been issued). Designed for the user that wants to get stuck 

straight into the data breakdowns. 

 

Graphical: this option will default your charts to show a more graphical, visually interesting 

representation of the data. The default will be to show the data in a variety of forms, using a 

range of charts and layouts, focusing more on the visual aspect than the other two options (for 

example less common chart types and 3D options where available will be used). Designed for 

the user that wants to create and download charts for presentations and reports, especially 

useful when the opportunity exists to present and explain the data, providing the possibility to 

be a little more creative with the chart’s look and feel. 

 

Display 

 

Select what data and charts are displayed by default on the Dashboard page. 

 

Styles 

 

Change theme settings & chart style to adapt the look & feel of PatBase Analytics V2. 

 

Groups 

 

Within the groups section, you can: 

• Turn on and off your groups (these can be also be individually turned on and off 

in specific graph settings) 

• Download/upload group files by using the blue download/upload icons 

Note that groups can be shared with colleagues 

• View your groups by clicking the pop-up icon (or the group counter) 

• Manage how the groups appear in your graphs, i.e. bold, italic etc. 

• (To edit the groups themselves, please visit the related section) 

 

Reset 

 

Reset one or more of your settings, these include: Analysis Settings, Display Settings, Your 

Personal Settings. 

 

Please note: by using any of these reset methods, you will permanently lose the relevant 

current setting. 
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Personal & logo/avatar 

 

Personalise your analytics display and reports by adding your name, company and photo or 

logo.  

 

We recommend either a passport style photo if this is to be your report, or your company logo 

if you'd like company branding on your reports. 

 

Please note: your image will be resized to 130 x 130 pixels - to retain the correct aspect 

ratio you may like to crop and or resize your image before uploading it. 

 

Shortcuts  
 

To aid navigation around Analytics there are a number of keyboard shortcuts available. 

To use these shortcuts, hold down the [Ctrl] and [Alt] keys, and then press one of the 

following: 

 

R Reset current graph 

A Re-run the current analysis 

S Go to your saved searches 

D Go to the analysis settings 

F  Force full re-analysis 

1 Reanalyse at the Basic depth 

2  Reanalyse at the Standard depth 

3 Reanalyse at the Deep depth 

B Switch to Breakdown display 

N Switch to Numerical display 

G Switch to Graphic display 
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Chart Settings 

 

Charts are available in numerous types and forms, such as column, pie, scatter etc., with 

the most appropriate display as the default setting. This can be changed by using the 

options in the “Chart Settings” menu at the top of each graph. In the “Type” tab, you can 

select the chart type and, depending on the type selected, modify the chart by selecting 

the options and 3D settings. 

 

 
 

Within the chart settings you can also modify the “Titles”, “Layout”, and “Data” shown, 

including the ability to edit and apply jurisdiction and assignee groups. There is also a button 

which allows you to view the raw data on which the chart is based. From the raw data tables, 

you have the ability to view or take the specific data back into PatBase by clicking the data in 

question. 

 

 
 

Finally, within the chart settings, you can export, print a chart, or share a chart with a 

colleague using the Generate Share Link function (See also: “Download, export, print or save 

graphs” on page 37). 
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Sharing a graph 

 

Clicking on the “Generate Share Link” button launches a pop-up window where you can 

preview the chart you are sharing, copy & share the URL, and publish the chart so that it is 

accessible publicly 

 

 
 

The options link allows you to add an expiry date for the public chart and add a note for the 

recipients. Once added, click “Back” and either preview or publish your final chart. 

 

 
 

Be sure to publish the chart to make it available publicly. If you only preview the chart a warning 

message will appear at the top of the chart reminding you to publish the chart. 

 

The PatBase Analytics Viewer allows the recipient to view the chart shared and make minor 

alterations to the chart layout via the chart menu. They are also able to find out more 

information about PatBase Analytics and Minesoft via the “Information” option. 
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Analysing data by jurisdiction 
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Clicking on Jurisdiction in the Analytics menu reveals the Jurisdiction menu where the 

following options are available: 

 

Summary 

 

A chart showing the number of families, applications, grants, and priority filings that have been 

filed in a specific jurisdiction. Data for families is represented by one or more publication(s) 

having been filed in a specific jurisdiction, and data for priority filings shows the number of 

families by earliest priority jurisdiction.  

 

The “Chart Settings” allow you to select the data visualised in the chart and the type of chart, 

as well as edit the jurisdiction groups.  

 

 
 

Jurisdiction by assignee 

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) filed by the top assignees in a specific jurisdiction. 

 

Jurisdiction by classification 

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) within a specific technology area (based on IPC and CPC classification codes) or 

with a specific IPC/CPC classification code that have been filed in a specific jurisdiction. 

 

Jurisdiction by year  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) filed over the past number of years in a specific jurisdiction. 
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Jurisdiction by legal status  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) filed in a jurisdiction, broken down by the latest legal status event group (e.g. 

LSPB = published, LSGT = granted etc.). 

 

Please note: In the cases of jurisdiction/families and jurisdiction/applications, the 

total count of jurisdiction hits may exceed the total number of families and 

applications being analyses. This is because one family may have publications 

and/or applications in multiple jurisdictions. 

 

Jurisdictions may be grouped using the jurisdiction grouping dialogue which is accessible 

from the “Data” tab in all Jurisdiction sections. 

 

 

Analysing data by year 
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Clicking on “Years” in the menu reveals a menu where the following options are available: 

 

Summary  

 

A chart showing the number of families, applications, grants and priority filings that have been 

filed each year for the last number of years. The chart shows the number of families with 

published activities in any given year, the number of priorities by earliest (filing) date, the 

number of applications by application date and the number of granted patents by grant date. 

Note that the chart settings allows you to select the data visualised in the chart and the type 

of chart. 

 

Years by Jurisdiction  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been published over time in the top jurisdictions. 

 

Years by Assignee  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been published over time by the top assignees. 

 

Years by Classification  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been published over time in the key technology areas (based on IPC and 

CPC classification code) or with the top IPC or CPC classification codes. 

 

Year by Inventor  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been published over time by the top inventors. 
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Analysing data by assignee 

 

 
 

Clicking on “Assignees” in the menu reveals a menu where the following options are available: 

 

Summary  

 

A chart showing the number of families, applications and grants that have been ordered by 

the top assignees.  

 

Assignees by jurisdiction  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been filed in the top jurisdictions by the top assignees. 

 

Assignees by year  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) filed over the past number of years by the top assignees. 

 

Assignee by classification  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been filed in the key technology areas (based on IPC and CPC 

classification code) or with the top IPC or CPC classification codes by the top assignees. 
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Assignees by legal status  

 

A chart showing the number of families, applications or grants filed by the top assignees 

broken down by the latest legal status event group (e.g. LSPB = published, LSGT = granted 

etc). 

 

 

 
 

Assignees may be grouped using the assignees grouping dialogue which is accessible from 

the Data tab in all Assignees sections. 
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Analysing data by inventors 

 

 
 

Clicking on “Inventors” in the menu reveals a menu where the following options are available: 

 

Summary  

 

A chart showing the number of families, applications and grants that have been filed by the 

top inventors. Note that the chart settings allows you to select the data visualised in the chart 

and the type of chart. 

 

Inventors by Year 

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) filed over the past number of years by the top inventors. 

 

Inventors by Classification  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been filed in the key technology areas (based on IPC and CPC 

classification code) or with the top IPC or CPC classification codes by the top inventors. 
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Analysing data by classification codes 

 

 
 

Clicking on “Classifications” in the menu reveals a menu where the following options are 

available: 

 

Summary  

 

A chart showing the number of families, applications and grants separated into the top 

technology areas (based on IPC and CPC classification code). Note that the chart settings 

allows you to select the data visualised in the chart, the type of chart and the classification 

schema of interest. 

 

Classifications by assignee   

 

a chart showing the number of families, applications or grants (selected from the chart 

settings) in the top technology areas or with the top IPC/CPC classification codes which have 

been published by the top assignees. 

 

Classifications by year  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) in the top technology areas or with the top IPC/CPC classification codes which have 

been published over the last number of years. 

  



Page 20 of 45 

PatBase Analytics V2 Guide 

support@minesoft.com 

 

Classifications by Legal Status  

 

A chart showing the number of families, applications or grants in the top technology areas or 

with the top IPC/CPC classification codes broken down by the latest legal status event group 

(e.g. LSPB = published, LSGT = granted etc). 

 

Please note: each main classification is only counted once for each family. 

 

Analysing data by agents 

 

 
 

Clicking on “Agents” in the menu reveals a menu where the following options are available: 

 

Summary  

 

A chart showing the number of families, applications and grants broken down by the 

prosecuting agent. Note that the chart settings allows you to select the data visualised in 

the chart and the type of chart. 

 

Agents by Year  

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been prosecuted by the top agents which have been published over 

the last number of years. 

  



Page 21 of 45 

PatBase Analytics V2 Guide 

support@minesoft.com 

 

Agents by Classification 

 

A chart showing the number of families, applications or grants (selected from the chart 

settings) which have been prosecuted by the top agents in the key technology areas 

(based on IPC and CPC classification code) or with the top IPC or CPC classification codes 

 

Analysing data by legal status 

 

Clicking on “Legal Status” in the menu reveals a menu where the following options are 

available: 

 

 
 

Summary  

 

A chart showing the number of families and applications broken down by the latest legal status 

event group (e.g. LSPB = published, LSGT = granted). Note that the chart settings allows you 

to select the data visualised in the chart and the type of chart. 

 

Dead or Alive  

 

A chart showing the number of publications which are dead or alive from a legal status 

perspective. 
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The Legal Status groupings are based on the PRS codes from INPADOC and the patent office 

codes from each National Patent Office. They are then allocated into a category to make them 

easier to manage.  

 

Please note: the legal status event groupings were put together by Minesoft and RWS to 

group INPADOC and National Patent Office event codes into a set of consistent groups. 

Analysing by keyword 

 

The Keyword tab provides visualisations of either frequently occurring keywords or concepts.  

 

The keywords option uses the most commonly occurring keywords (found within titles and 

abstracts), whereas the concepts option uses concepts semantically derived from the top 

classification codes (you can select which option to view from the Data tab within the Chart 

Settings). 

 

Either option will produce a set of clusters, with the families clustered by either the relevant 

keywords or the concepts. 

 

Cluster Rules 

 

When analysing by keyword you may find that you get some irrelevant keywords that occur 

frequently in the patent documents, for example “Present Invention”. These can be removed 

across all keyword landscapes and clusters by going to Cluster Rules in the Layout tab in chart 

settings: 

 

 
  



Page 23 of 45 

PatBase Analytics V2 Guide 

support@minesoft.com 

 

The basic cluster rules are shown in the table below: 

 

Rule Description Example 

Remove Enter the exact (case sensitive) 

name 

Light bulb, Light Fitting (1) 

Wildcard remove Use an asterisk (*) Light* 

Rename User a pointer (>) Light Bulb > Luminare 

Merge (2) User a plus (+) to join clusters 

and a pointer (>) to give the 

cluster a name 

Light Bulb + Light Bulbs > Luminares 

(1) This example includes comma separated multiple rules 

(2) Merging is only possible on the Landscape, it is not available in the keyword 

clustering view 

 

Keyword clustering visualisations 

 

Keywords or concepts can be displayed in either a circle, tree or word-cloud form, based on 

the selection made in the chart settings. 

 

When choosing the way that you want to display your keyword analysis, you can also choose 

whether to split the screen. If your screen is split, you will be able to click on a section of 

interest and view all related families to the right-hand side. Alternatively, if you choose to keep 

your screen unsplit then when you click on a section of interest a pop-up window will show 

related families instead. 

 

 
 

Please note: sometimes families do not contain an appropriate abstract, in which case 

they cannot be used by the clustering software; in addition, there is an upper limit for 

the number of families that may be clustered in which case no more than the maximum 

allowed (for the current analysis depth) will be taken into account. This means that not 

all families will appear in the keyword visualisations. 
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Circle clustering  

 

 
 

PatBase Keyword Clustered Circle is an interactive visualization of multi-level clustered and 

grouped family data.  

 

The clustered circle allows you to click and zoom in on a cluster (which is shown on the outside) 

to nodes (sub-clusters) on the inside. 

 

Click on the pink arrows to expand/collapse the number of clusters displayed. 
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Tree clustering 

 

 
 

PatBase Keyword Clustered Tree is an implementation of hierarchical Voronoi Tree maps. With 

animated transitions, zooming, searching, and nested meta data available via a split screen 

view.  

 

The clustered tree allows you to click and zoom in on a cluster and zoom further to nodes 

(sub-clusters). 

 

Word Cloud clustering 
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A Word Cloud takes clustered keyword data (in our case patent documents that are organised 

into clearly labelled thematic groups), and then presents the keywords (thematic groups) 

relative to their size. The idea is to provide an attractive easy to understand visual 

representation of a large dataset in one easy to consume graphic.  

 

Please note: the requirements of the Word Cloud mean that layout takes precedent over 

content, and as such – while the word cloud provides a nice intro or overview into a 

subject area - conclusions or analysis should only be drawn in conjunction with other 

analysis. 

 

Landscapes 

 

Keywords or concepts are displayed in either a 2D or 3D landscape view, based on the selection 

made in the chart settings.  

 

 
 

The 2D landscape highlights commonly used keywords (or concepts) as clusters, with intensity 

(occurrences) in line with the implied "height" of the landscape, with the blue "sea" being low-

lying (fewer families) and the land (from coast to peak) being "higher" and therefore 

representing more families. If you have trouble distinguishing clusters, try increasing the 

available height in the Layout tab. 
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The layout of the landscape can be modified using the chart settings, where the form of cluster 

& family markers can be selected, as well as visual features such as font size & colour. If you’re 

viewing a 3D landscape you would also have the option to alter the altitude between flat, hilly 

or mountainous, like below. 

 

 
 

The 3D (topographical) landscape works as per the 2D landscape, except it renders the third 

(Z) dimension displaying the "height" in a 3D rendering instead of just implying height by 

colouring (as the 2D version does). Therefore "hot" clusters (those with more families) are 

shown as relative "height" in the z-plane. 

 

The perspective of the 3D landscape can be modified by using your mouse by holding the left 

button and dragging across the landscape. The exact mode of rotation can be set using the 

context menu that appears top right when you hover over the landscape –  

( ) these include panning, orbital or turntable rotation - there is also a home 

button that you can use to reset the display. Use your mouse wheel to zoom in and/ or out. 
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As with clustering, you can also choose to view the landscapes in split screen view. As below: 

 

 

Citation Analysis 

 

Citation analysis allows you to investigate citations by jurisdiction, year and assignee. The 

absolute total number of citations will be shown on the dashboard.  

 

 
 

If you mouse over these figures, you’ll see the top 5 most citing (or cited) families. 
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If “Citation Analysis” is turned on in your analysis settings, then for each analysis you run, both 

forwards and backwards citations will be collected and analysed for jurisdictions, years and by 

assignee. This simply means that the citations are totalled up for each jurisdiction – forwards 

(from these jurisdictions) and backward (to these jurisdiction) – and the same applies for each 

year and each assignee (probable assignee is used). This means the cited (or citing) jurisdiction, 

the cited (or citing) year and/or the cited (or citing) assignee. 

 

 
 

Please note: there are some limitations on which citations are used. Due to the nature of 

citations, the number of citations can grow quickly and exponentially as the number of 

families being analysed increases. Therefore, we use a sample when the analysis reaches 

a specific threshold - this threshold is 500 families when the Standard analysis is used 

and 1000 when a Deep analysis is run. If you are analysing more families than this, then 

only this many families will be taken (at random) and the number of citations will be 

calculated from this sample. 
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Citation Networks 

 

PatBase Analytics V2 Citation Network Explorer creates visual representations of complex 

patent citation networks. This tool creates a graph network for citations of the set of families 

in your result-set. 

 

The first thing to know is that while all nodes represent a specific assignee, there are two main 

types of node: 

• Parent nodes – formed from at least one family from your currently analysed result 

set (i.e. if an assignee in your search is cited or citing that it is a Parent Node) 

• Citation nodes – consist only of a citing (or cited) assignee (i.e. if the assignee does 

not otherwise appear in the result set). If you look at the network below, you’ll see 

a network that is formed from just one family (55704793), the assignee of the 

family is Procter and Gamble which therefore forms the sole parent node (in the 

centre) 

•  

 
 

The Citation Network is a graphical representation of citations (represented as edges) between 

selected entities (represented as nodes). It is constructed as a Network Graph using nodes and 

edges. The nodes currently only represent assignees. 

 

The size of the node is relative to the total number of citations to (or from) that node. So, an 

assignee with lots of citations appears as a large node, and assignee with fewer citations 

appears as a smaller node. 

 

The links, known as "edges" in a network graph, represent the citations to or from each of the 

nodes. To be precise - a single edge represents any number of citations from one assignee to 

another. So, you should interpret an edge between two nodes as representing at least one 

citation of the selected direction (either forward or backward). 
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The absolute number of edges therefore shows the unique number of citing (or cited) 

assignees. That is - one edge represents a unique assignee to assignee link (set of citations).  

 

The simulation menu 

 

The network is based on simulated "forces", these separate the nodes, stop nodes overlapping 

and define the length of the edges. For example: larger nodes exert a proportionately larger 

outward "pushing" force (called Node Force), this means that they clear some space around 

themselves and are therefore more readily identified. The simulation menu allows you some 

control over these fundamentals of the simulation. 

 

 
 

The image on the previous shows the simulation menu, the specific parts of it are: 

 

Network controls: 

• Stop – turn off all currently applied forces, this has the effect of stopping all current 

node interactions, if there are any 

• Continue – turn on all current forces, this has the effect of starting (or un-pausing) 

all current node interactions 

• Push – gives all the forces a little "shove" by slightly re-powering the strength of 

the forces (this added power will then degrade as normal) 

• Redraw – this will simply redraw the active network using the current settings 

 

Forces:  

• Auto set forces – will automatically adjust the Node and Citation Forces until all 

nodes sit nicely within the Network Panel 

• Node force – this is the repulsive force between nodes, the larger the force the 

more the nodes repulse each other 

• Citation force – determines the length of the citation links, the larger the force the 

longer the citation links appear 

 

Pinning: 

• Pin node position after dragging – nodes are pinned in place once you drag them 

to a location. You can turn off this behaviour using the checkbox. You can also 

unpin all pinned nodes by using the Unpin All button 
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The nodes menu 

 

The Node Menu is where you have control over the number (and the type) of nodes to be 

displayed, so by using this menu you can easily create a network that you can readily 

interpret on screen. You are really just controlling what part of the complete network that is 

being rendered to the screen, the entire network exists, you are just selecting which part to 

view. 

You can also manage the node labels, toggle them on or off, set the threshold, size, and 

control the node tooltips and network highlighting. 

 

 
 

Nodes (entities): 

• Threshold 

— The threshold number of citations required for a node to be included in the 

network graph 

— You can enter a custom number in the box at the end, should you wish 

— The "Auto" option will automatically select a threshold that means that the number 

of nodes falls below the Node Limit 

• Node limit 

— The node limit, this is the maximum number of nodes allowed. 

— This needs to be carefully managed, as too many nodes can become unintelligible, 

and/or significantly slow down your browser 

• Result-set only 

— The “Result-set Only” setting will switch between accounting for only nodes and 

citations that originate within the current result-set or not 

— When this is set to No all citations are used - regardless of their origin, when it is 

set to Yes, only citations which originate from within the current set will be counted 

• Isolated nodes 

— Isolated Nodes are nodes with zero citations, they therefore do not form part of 

network at all. The reason that these occur is that they may have one (or more) 

citations, but not from (or to) any of the other nodes currently shown in the 

network 

— They will have a connecting node, but any number of settings may cause the 

connecting node to not be shown. You can switch them on or off here 

• End nodes 

— End Nodes are nodes with only one citation, therefore they do not form part of an 

extended network 

— They can be turned on or off here 
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Nodes Labels/Tooltips 

• Text – set the contents of the node labels. This is literally what label text will 

contain, either the assignee name, the number of citations or a combination.  

• Size – adjust the size of the node labels.  

• Threshold – the threshold above which node labels are shown. For example, when 

25% is selected labels will be shown for nodes which have a number of citations 

that fall in the top 25% when compared to the maximum 

• Tooltip – this is the mouseover for the network itself (what happens when you 

mouseover a node). Details are displayed in a tooltip, the network highlight option 

highlights the network adjacent to the current node. You can also select both or 

none. The pin will pin the tooltip to the edge of the network so that it doesn't 

obscure the network itself.  

 

The citations menu 

 

The citations menu is focusses on the citations – the “edges” in the network 

 

The main feature here is the Direction (Forward/ Backward) toggle - any network will display 

only forward or backward citations - the default being forward. The Style option changes the 

type of edge straight/ curved or relative (this option renders the edge with a width relative to 

the number of citations that it represents). 

 

 
 

The colour option is either all grey, "as per group" (which is set to assignee in this version), or 

as per the direction blue for forward citations and red for backward citations. 

 

Note that the citation labels are off by default, you can use the marked toggle to switch them 

on (marked on the image above). There are also size and threshold options for these labels.  

Reviewing saved searches 

 

PatBase Analytics V2 keeps a history of your previous searches within the “Your Searches” 

menu under “Analysis” in the main menu.  

 

Details of each previous search are displayed including the date created, date last analysed in 

Analytics, number of families, jurisdictions and applications analysed, depth and settings. The 

drop-down menu for each saved search allows you to rename, lock the analysis to prevent its 

removal from the saved searches after 21 days, re-analyse the original data in Analytics, re-run 

the search in PatBase, edit the search, view the notifications of new data based on your query, 
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and delete the saved search. There is also an option to compare analyses, this will be covered 

in more detail in the next section. 

 

 

Comparison Analyses 

 

The comparison analyses option directly compares result sets side-by-side. This makes it easy 

to compare patenting trends, whether it’s between two competitors, one company at two 

different periods of time or two parallel technology areas etc.  

 

To run a comparison analyses, begin by loading an analysis for two different result sets. Once 

each analysis has fully loaded it will be automatically added to “Your Searches”. This example 

will compare the recent portfolios of Unilever and Procter and Gamble.  
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Tick the “Compare” check box in the drop-down menu, note that two squares should appear 

once the box has been ticked indicating which (once selected you will see a large red icon  

next to each analysis). Then click the red “Analyse” button (or the “View” button if they are 

already analysed) on either of the selected searches. 

 

If the searches are not analysed then the analysis (based on your current settings) will run as 

normal, but one after the other. 

 

Once both of the selected analysis has run you will automatically be transferred to the 

comparison dashboard. 

 

In addition - when available - you can add a comparison analysis to a current analysis by 

clicking the compare icon in the “Analysis Switcher”, two things have to be true for this to be 

available. Firstly, only analysed searches appear in the Analysis Switcher so the analysis you 

want to add must have been analyses. Secondly you must be on a page (in a section) that 

allows for comparison graphs, in general this means the dashboard, or a Summary section.  

 

Please note: the Analysis Switcher is not available when viewing a comparison, so 

you'll need to remove an analysis before selecting a new one to compare (more on how 

to do this later). 

 

 
 

Once two analyses have been selected, they will both be shown on the dashboard with 

associated details (the analysis on the left in known and the Primary Analysis, and the one on 

the right as the Comparison Analysis. In the example below, Procter and Gamble is shown as 

the Primary Analysis, and Unilever as the comparison analysis. 
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You can go through the categories in the menu as normal, the only difference being that a 

comparison analysis only shows the Summary charts. 

 

 

Running Basic, Advanced & Number searches 

 

PatBase Analytics V2 allows you to run a Numbers search (by pasting family numbers into 

the input box), Basic search (using keywords, assignees, publication dates and jurisdictions) 

or Advanced search (using PatBase command line language) in PatBase and then analyse this 

new dataset directly in PatBase Analytics.  
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Automated reporting 

 

This option in Analytics V2 automates the generation of reports that can be exported and 

edited/printed/shared etc. Currently, Analytics V2 reports can be exported as PDF, Word, or 

PowerPoint files.  

 

There are 4 types of reports available: 

 

• Overview summary report – provides a full overview of an analysis, covering all 

primary areas at a basic level (available as an 8-10 page / portrait option)  

• Summary datasheet – provides a brief overview of an analysis, covering only a basic 

level but for a range of metrics (available as 2 – 3 page / landscape / 1 chart per 

page option)  

• Assignee datasheet – provides a brief overview of a selected assignee within an 

analysis, this report covers the basic data but for a range of metrics 

• Jurisdiction datasheet – focusses on the jurisdiction data of the current analysis  

 

To generate a report, select Reports from the Analytics V2 menu.  
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Alternatively, you can generate a report directly from the Analysis Choices page. 

 

 
 

As you hover your mouse over the different options, a tooltip will appear with a description 

of each report type.  

 

Please note: the analysis that runs will be specific to the requirements of the selected 

report, so only those components required for the report will be analysed. If you are 

unsure which report to choose, run a full “Direct Analysis”, where you will have access 

to all reports from the menu as mentioned above.  

 

 

The final way to access the Analytics V2 reports is via your saved searches.  
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The red check means that there is a custom report or “template” available for this analysis 

already. A green check means that all data required to complete the report is available (has 

been analysed), and you will be taken directly to the report from the saved searches page.  

 

If you select a report that doesn’t have a green check then it will have charts missing. 

However, you run the report regardless and then navigate to the “Data Required” button in 

report settings and then select “Re-Analyse with these Components” from the pop-up 

window to complete the report.  
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Editing the report template 

 

 
 

Once loaded you will be directed to a page like the above image with a list of charts, 

categorised into pages. In the top right-hand corner for each page there are options to 

download a specific page as a PDF, PNG, JPEG or to print the page. There is also an 

information icon to give more of a breakdown of each of these download options.  
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You can interact further with each graph, for example zooming in and out of the heat map, 

adjusting the basic setting options (just look for the settings icon ).  

 

 
 

You can adjust the number of data points shown, i.e. number of jurisdictions included, 

number of years, et cetera; add labels, i.e. show the exact numbers in the graphs; or adjust 

the type of graph used. This will show a different set of options depending on the chart type. 

 

Where a graph is showing multiple types of data, for example, families and applications. 

There will be an arrows icon at the bottom right-hand corner . Clicking this will change 

the order that the selected metrics are shown in, this works hand-in-hand with the ability to 

turn on or off the displayed metrics using the legend (simply click “families” or “applications” 

etc. to turn them on/off or show/hide them). These changes are stored in the default 

template. 

 

Highlight editable text 

 

When editing the report, there are some areas of text which can also be changes, to identify 

these areas, select “Highlight Editable Text” under report settings. Editable areas will be 

outlined with a red dotted line, like below: 
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When clicking on these areas, you can remove or add content, or make formatting changes. 

All these changes can be saved in a “default” template by clicking “save” under report 

settings.  

 

 
 

Report settings 

 

 
 

Report data – toggle off/on assignee or jurisdiction groups, for information about the 

highlight assignee option please read next sub-section 

Pages – minimise or maximise all pages/graphs, adjust page size, change to one chart per 

page, highlight any editable text 

Export – decide whether or not to include a title page, export the report as a Word, 

PowerPoint or PDF document.  

Please note: there is a “warning” triangle next to the PDF export option because the 

PDF is generated directly from the screen, therefore the picture quality may not be 

great depending on the user’s screen resolution. To rectify this, choose the Word export 

option and then “Save As” a PDF from Microsoft Word.  

Templates – save the current template, save the current template with a different name for 

future use, load a saved template, reset a default template or delete a custom template. 

Help & Info. – see a description of the type of report you have generated, check if any 

further data needs to be analysed or view a diagram on using templates 
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Highlight assignees/jurisdictions 

 

The highlight assignees/jurisdictions option will allow you to select and highlight one or 

more assignees/jurisdictions of particular interest. This will highlight them within the report 

and allow you to compare and contrast their positions within the current result set/report.  

 

To open the option, click “Highlight Assignee(s)” from “Report Settings” from the assignee 

data sheet or click “Highlight Jurisdiction(s) from the jurisdiction datasheet.  This will open a 

pop-up window like below. 

 

 
 

Using the example of assignee highlighting: Select the assignees you’re interested in by 

ticking the checkbox next to the assignee name, for example, Waymo & IBM, and click “OK”. 

The selected assignees will then be highlighted within the report, like in the example below: 

 

 
Please note: turn groups on from “Report Settings” to include assignee or jurisdiction 

groups.  
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Download, export, print or save graphs 

 

Download or print 

 

Options to print or download an image can be found at the top-right of the graph by clicking 

on the chart context menu, or in the Chart Settings under the info/share/download tab.  

 

 
 

Choose to print the chart of download as a PNG, JPEG, PDF or SVG. The file can also be 

downloaded as a CSV or XLS for further manipulation. 

 

Export  

 

The underlying data can be exported from within the Chart Settings as either an Excel, XML, 

CSV, HTML and JSON file. 
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Contact us 

 

Please contact support@minesoft.com if you have any further questions or queries, or you 

require help with anything you have seen in this guide. 
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